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PELUANG USAHA DALAM BISNIS DISTRO DENGAN
MEMANFAATKAN KETERAMPILAN CORELDRAW

Nurul Aini

Abstract: CorelDraw is an application programs that much used by professionals in
graphic design. CorrelDraw can be used for designing, creating various shapes, and
managing the colours. This program is easy to handle and operate therefore it can be
applied for designing the distro (distribution outlet) t-shirt. Designing skills of the
distro t-shirt using CorelDraw is required for being distro designer. The important
things that could be counted in designing distro t-shirt is creativity of ideas and
inspirations. Meanwhile, there are several factors influenced the successfulness on
distro business. The factors could be the capital, promotion, marketing, and distri-
bution.

Abstrak: CorelDraw merupakan program aplikasi yang banyak dimanfaatkan oleh
kalangan profesional dalam pembuatan desain grafis. CorelDraw dapat digunakan
untuk mendesain, membuat berbagai bentuk, dan memberi warna. Program ini mudah
untuk dipahami dan dioperasikan sehingga dapat dimanfaatkan untuk mendesain kaos
distro (distribution outlet). Keterampilan dalam membuat desain kaos distro meng-
gunakan CorelDraw diperlukan untuk menjadi desainer kaos distro. Hal yang perlu
diperhatikan adalah kreatifitas dalam menciptakan ide atau inspirasi yang dituangkan
dalam bentuk desain kaos distro. Sementara itu terdapat beberapa faktor yang mem-
pengaruhi keberhasilan dalam bisnis distro. Faktor-faktor tersebut antara lain modal,
produksi, promosi, pemasaran, dan distribusi.

Kata-kata kunci: CorelDraw, desain, kaos distro

orelDraw merupakan program apli-

kasi yang banyak dimanfaatkan oleh
kalangan profesional dalam pembuatan
desain grafis. CorelDraw dibuat dengan
alat-alat atau perintah-perintah yang mudah
untuk digunakan. Biasanya program ini
digunakan untuk keperluan cetak, web,
maupun untuk keperluan lainnya (Wibowo,
2002). Dalam artikel ini, CorelDraw dapat

dimanfaatkan dalam pembuatan desain
kaos distro. Terampil dalam membuat
desain kaos distro atau dengan kata lain
menjadi desainer kaos distro merupakan
salah satu peluang untuk membuka bisnis
distro. Seperti dikatakan Hariyadi (2007),
desain kaos distro merupakan salah satu
trend desain yang marak akhir-akhir ini.
Ciri khas dalam desain ini sangat diminati
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masyarakat, terutama kalangan anak muda.
Selain berfungsi sebagai fashion, kaos
distro juga merupakan simbol apresiasi
seni bagi pemakainya. Pendapat lain,
menurut Kusuma (2007), bahwa daya tarik
kaos distro terpusat pada elemen visual-
nya seperti: (1) gaya seni grafis tersablon-
nya sangat kental; (2) mempunyai daya
tarik simbolik yang unik; (3) bergaya
anak muda; dan (4) memiliki kebebasan
sesuai dengan idealismenya.

Distro atau distribution outlet adalah
tempat untuk menjual kaos, pakaian, se-
patu maupun pernak-pernik lainya yang
memiliki desain unik. Biasanya produk
distro dkeluarkan dalam limited edition
atau terbatas produknya, sehingga ada
kebanggaan tersendiri untuk mengenakan
produk distro (Wino, 2009). Bisnis distro
merupakan peluang bisnis yang cukup
menjanjikan. Seperti disebutkan Idebis-
nisusaha (2009), bahwa beberapa tahun
terakhir bisnis distro yang merupakan
singkatan dari distribtion outlet cukup
ramai di kota-kota besar bahkan peminat
dari produk distro menjangkau ke seluruh
Indonesia.

Dengan demikian, bila terampil atau
dapat memanfaatkan CorelDraw dengan
baik, akan merupakan peluang usaha un-
tuk membuka bisnis distro. Untuk itu,
dalam artikel ini akan dibahas berbagai
hal yang berkaitan dengan CorelDraw,
desain kaos distro dengan CorelDraw,
dan bisnis distro.

PEMANFAATAN KETERAMPILAN
CORELDRAW

Aplikasi Desktop Publishing dibagi
tiga kelompok, yaitu aplikasi pengolah
foto/piksel, pengolah vektor, dan tata
letak (layout). Aplikasi pengolah foto/
piksel adalah program pengolah image/
foto memiliki fungsi memperbaiki foto,
memodifkasi foto, menggabungkan dua
foto menjadi satu, dll. Contohnya adalah
Adobe Photoshop, Corel Photo Paint,

Microsoft Photo Editor dIl. Program-
program ini biasa digunakan membuat
cover buku yang menampilkan gambar
foto. Aplikasi pengolah vektor atau peng-
olah garis adalah aplikasi untuk meng-
gambar bentuk digunakan untuk membuat
bentuk-bentuk baru, menggambar, me-
modifikasi huruf atau ambar 2 dimensi,
bisa dignakan untuk membuat logo, gam-
bar kartun dll. Aplikasi tata letak (layout)
adalah aplikasi untuk mengatur tata letak
huruf dan gambar, memposisikan gambar
dan huruf supaya lebih menarik, misal-
nya pada tata letak tulisan koran atau
majalah. Selanjutnya, sesuai dengan judul
artikel, maka yang akan dibahas adalah
CorelDraw yang merupakan aplikasi peng-
olah vektor atau garis (Zakian, 2010).

Program CorelDraw adalah sebuah
program yang digunakan oleh para de-
sainer untuk membuat gambar-gambar
yang bentuknya tidak hidup. Berbeda
halnya dengan Photoshop, yang diolah
adalah foto-foto yang bentuknya hidup
(foto asli yang diolah). CorelDraw sangat
menarik untuk ditekuni, karena itu ke-
biasaan menekuni CorelDraw merupakan
kunci dalam pengembangan skill untuk
menguasai program ini.

CorelDraw adalah program yang di-
gunakan oleh orang untuk membuat
poster-poster, logo, kop surat, dan lain
sebagainya. CorelDraw merupakan pro-
gram aplikasi yang menarik asalkan punya
keinginan dan bakat dibidang seni. Selain
itu, kunci dalam mempelajari CorelDraw
adalah dengan keaktifan untuk terus ber-
latih. Intinya adalah jangan takut untuk
mencoba dan terus membuat karya.

Kelebihan dari CorelDraw adalah
program ini tidak akan membuat image
gambar pecah meskipun dibesarkan sesuai
dengan Kkeiginan kita. Berbeda halnya
dengan Photoshop, yang harus diperhati-
kan terus image size-nya. Bila image size-
nya ketika di save berukuran kecil, maka
ketika diolah untuk diperbesar gambar
akan mengalami kekaburan (pecah). Bila



mengambil gambar-gambar dari internet,
maka perlu diperhatikan image size-nya,
karena ukuran gambar tidak akan dapat
dipaksakan untuk diperbesar bila dasar
image-nya berukuran kecill.

Program grafis ini memang begitu
besar pengaruhnya terhadap perkembang-
an desain komputer pada umumnya. Ba-
nyak pengguna yang menyatakan bahwa
perkembangan CorelDraw telah begitu
pesat mempengaruhi perkembangan seni
grafis digital yang semakin mempesona.
Perkembangan software desain grafis
telah mempengaruhi pula pandangan ten-
tang seni digital yang baru ini. Peman-
faatan CorelDraw telah merambah ke
semua bidang tidak hanya desain grafis
semata, sehingga pemakaian CorelDraw
semakin banyak diminati karena keluwes-
annya serta kemudahannya dalam hal
pemakaian tool yang disediakan untuk
memenuhi segala kebutuhan publikasi
(Kusuma, 2003).

Seperti diuraikan di atas, bahwa pro-
gram CorelDraw merupakan aplikasi pro-
gram yang digunakan untuk menggambar,
membuat logo, kartun, gambar 2 dimensi,
baju, dll. Dengan demikian, CorelDraw
merupakan salah satu program desain
grafis yang dapat digunakan dalam pem-
buatan desain kaos distro. Seperti di-
nyatakan Tim Cyan Agency (2009), bah-
wa program komputer sederhana berbasis
desain grafis vektor seperti CorelDraw
dapat digunakan untuk membuat berbagai
desain kaos untuk keperluan distro. Pro-
gram ini termasuk mudah untuk me-
mahaminya. Seperti yang dikatakan
Sukirman (2009), bahwa CorelDraw me-
rupakan salah satu perangkat lunak desain
grafis yang sangat populer, banyak orang
memakainya karena mudah dalam meng-
operasikannya. Dengan memiliki perang-
kat Personal Computer (PC) yang di
dalamnya terdapat software CorelDraw,
maka setiap orang dapat dengan mudah
menguasainya.
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CorelDraw dapat digunakan untuk
mendesain, membuat berbagai bentuk,
dan memberi warna. Hal yang perlu di-
perhatikan adalah kreatifitas dalam men-
ciptakan ide atau inspirasi yang dituang-
kan dalam bentuk desain kaos distro.
Senada dengan pendapat Iskandar (2006),
bahwa hal terpenting bila telah terampil
dalam pengoperasian CorelDraw adalah
eksploratif, sehingga karya yang dihasil-
kan memiliki karakter, kreatif, komuni-
katif, dan efektif. Dalam pembahasan
CorelDraw ini lebih ditekankan pada hal-
hal yang berkaitan dalam pembuatan
desain kaos distro.

Untuk membuat desain distro dengan
program desain grafis CorelDraw, perlu
menguasai fasilitas apa saja yang diperlu-
kan dalam pembuatan desain, khususnya
desain kaos distro, yaitu sebagai berikut.

Pengenalan Tools CoralDraw

Tampilan jendela kerja CorelDraw
merupakan tampilan layar yang ada di
monitor pada saat membuka program
CorelDraw. Tampilan tersebut memuat
tentang Tittle Bar, Menu Bar, Toolbar
(standard), Property Bar, Toolbar, Ruler,
Color Palette, Drawing Window, Draw-
ing Page, status Bar, Document Navi-
gator, Navigator, dan Docker. Tampilan
jendela CorelDraw dapat dilihat pada
Gambar 1.

Pengenalan Menu-menu yang Ada di
CorelDraw

Jika saat menggunakan CorelDraw
kehilangan Standar Tool Bar, Property
Bar, dan Toolbox, cukup dikeluarkan
atau ditampilkan kembali dengan meng-
klik menu Window » Toolbars » Standar,
atau Window » Toolbars » Property Bar,
atau Window » Toolbars » Toolbox. Jika
kehilangan Color Pallete, klik menu
Window » Color Palletes » Default CMYK
Pallete, begitu juga jika ingin menampil-
kan Docker, hanya dikeluarkan di menu
Window.
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Gambar 1. Tampilan Jendela CorelDraw
(Sumber: Zakian, 2010)

Pengenalan Tool Box dan Cara Mem-
baca Nama Peralatan

Untuk mengetahui nama-nama menu
atau nama Tool Box dengan cara men-
dekatkan kursor ke Menu atau ke Tool
Box. Jika pada Tool Box terdapat tanda
segi tiga kecil , artinya ada peralatan lain
di dalamnya, peralatan lain tersebut bisa
dibuka dengan mengklik lebih lama pada
gambar yang ada segitiganya.

Fungsi Properties

Setiap Kklik pada Tool Box, Property
Bar-nya akan berbeda-beda. Fungsi pro-
perties adalah untuk melakukan pemilihan
yang lebih detil. Properties Bar Pick Tool
di klik Pick Tool pada Tool Box akan
keluar Property Bar seperti Gambar 1.
Jenis kertas yang akan digunakan dapat
dipilih langsung dari option jenis kertas

yang ada, dengan mengklik dahulu ke-
mudian melakukan pilihan. Jika jenis
kertas yang diinginkan tidak ada pada
pilihan, Kkita dapat menentukan sendiri
yaitu dengan mengubah angka-angka
panjang dan lebarnya, kemudian tekan
Enter. Klik untuk membuat kertas men-
jadi vertikal atau horisontal. Satuan pan-
jang kertas bisa dipilih sesuai keinginan,
tinggal memilih ke centimeter, milli-
meter, inches, dll.

Area Menggambar

Pada Standar Tool Bar terdapat angka
yang ada persennya (%) yang merupakan
persentase kertas yang dilihat. Jika
dirubah ke 100% kertas dapat dilihat
keseluruhan, 50% separuh kertas. To Fit
sebesar gambar, To Page seluruh halaman
kertas, To Width dilihat seluruh lebar



kertas, To Height dilihat seluruh tinggi
kertas. Kertas dapat juga dilihat lebih
besar/lebih kecil dengan memutarkan
roda pada mouse, atau menggunakan
Zoom Tool pada Tool Box. Jika saat
menggambar kehilangan kertas, maka
dapat dengan mengubah persentase yang
ada di atas ke dalam To Fit, atau To
Page, To Height, atau dengan mengklik
F4 pada keyboard. Untuk memperkecil
persentase bisa dengan mengklik F3.
Menggambar kotak menggunakan Tool
Box. Menggeser, memperlebar, memper-
tinggi, memutar, dapat menggunakan
Pick Tool. Untuk menghapus sebuah
gambar, klik dahulu gambarnya meng-
gunakan Pick Tool kemudian tekan delete
pada keyboard.

Memberi Warna pada Kotak

Klik kiri objek yang dibuat, kemudian
memilih warna yang diinginkan dengan
cara meng klik Color Pallete, selanjutnya
objek akan berubah warna sesuai dengan
yang diinginkan. Klik kanan pada Color
Pallete untuk memberi warna pada garis
kotaknya. Pilih ketebalan garis pada Out-
line Width sesuai ketebalan yang diingin-
kan.

Memberi Nama Halaman, Membuat
Halaman Baru, dan Menghapus Ha-
laman

Untuk memberi nama halaman, klik
pada tulisan Pagel, kemudian klik Re-
name Page, ubah namanya kemudian
tekan enter. Insert Page After untuk mem-
buat halaman baru setelahnya. Insert Page
Before untuk membuat halaman baru se-
belumnya. Delete Page untuk menghapus
halaman.

Mengimport Gambar

Untuk mengimport sebuah gambar,
klik menu File » Import, kemudian pilih
file gambar, klik lagi import, tempatkan
gambar sesuai keinginan. Pada menu File

Aini, Peluang Usaha dalam Bisnis Distro 213

terdapat sub menu Open, sub menu Open
ini digunakan untuk membuka file-file
yang sebelumnya di gambar mengguna-
kan Corel dan memiliki tipe file CDR,
tidak bisa digunakan untuk membuka
gambar yang tipenya bukan CDR.

Membuat Guidline (Penggaris)

Untuk mengeluarkan garis bantu da-
lam menggambar, simpan kursor di atas
penggaris kemudian tarik ke bawah untuk
membuat garis horizontal. Untuk mem-
buat garis bantu vertikal, caranya sama,
klik dipenggaris sebelah kiri, drag (tarik)
ke sebelah kanan, jumlah penggaris dapat
dikeluarkan sesuai keinginan. Untuk
menghapus garis bantu, klik garis Bantu-
nya sehingga warnanya merah, kemudian
tekan delete pada keyboard.

Tool-tool untuk Membuat Garis dan
Objek, serta Membuat Teks

Dalam pembuatan desain kaos distro,
biasanya diperlukan berbagai fasilitas
untuk terciptanya suatu desain yang be-
rupa tool-tool dengan fungsi yang ber-
beda. Misalnya, tool-tool untuk membuat
garis dan objek, membuat teks, inter-
active tool, outline tool, fill tool, dan
interactive fill.

Untuk membuat garis menggunakan
freehand tool. Untuk mengedit garis
dapat mengubah style (bentuk), width
(ketebalan), dan arrowhead (bentuk titik
pada awal dan akhir garis). Untuk meng-
ubah style (bentuk) pada property bar
pilih outline style selector. Untuk meng-
ubah width (ketebalan) pada property bar
pilih outline width. Untuk mengubah
arrowhead pada property bar pilih start
arrowhead selector dan end arrowhead
selector. Mengubah garis lurus menjadi
lengkung klik shape tool pada toolbar,
lakukan Kklik sekali pada garis sampai
muncul titik hitam, kemudian klik kanan
mouse pilih to curve.

Untuk membuat objek, dapat meng-
gunakan rectangle tool, ellipse tool,
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polygon tool, spiral tool, basic shapes,
arrow shapes, flowchart shapes, star
shapes, dan callout shapes.

Untuk membuat teks atau artistic text
(kata atau kalimat yang pendek atau
singkat) menggunakan text tool. Editing
artistic text pada property bar dapat
memilih font size list dan horizontal
alignment. Untuk mengubah besar kecil
huruf dapat menggunakan menu bar text
kemudian pilih chang case. Untuk mem-
buat kalimat yang panjang dengan meng-
gunakan paragraph text. Untuk membuat
berbagai variasi text dapat menggunakan
drop cap, dan fit text to path.

Membuat berbagai Variasi Objek

Untuk membuat berbagai variasi ob-
jek dapat menggunakan kelompok inter-
active yang terdiri dari: interactive blend
tool, interactive contour tool, interactive
distortion tool, interactive drop shadow
tool, interactive envelope tool, interactive
extrude tool, dan interactive transparency
tool.

Outline pen yang terdapat dalam out-
line pen dialog digunakan untuk meng-
ubah color (warna), style (bentuk), width
(ketebalan), arrows (penambahan titik
pada awal dan akhir garis), mengubah
corners (sudut) garis, lines caps (meng-
ubah bentuk penutup awal dan akhir
garis), calligraphy (mengubah tampilan
garis), dan melakukan perubahan garis
mengikuti skala (scale with emage).

Fill tool digunakan untuk pengaturan
warna. Fill tool terdiri dari fill color
dialog, fountain fill dialog, pattern fill
dialog, texture fill dialog, dan post script
fill dialog. Untuk penggunaan atau pemi-
lihan fill tool disesuaikan dengan desain
yang dibuat.

Interactive fill tool fungsinya sama
dengan fill tool di atas, yaitu untuk mem-
beri atau mengatur warna. Ada dua ma-
cam, vyaitu interactive fill tool, dan inter-
active mesh fill tool.

Editing Objek

Pada saat menggambar dengan Corel-
Draw, biasanya diperlukan pengetahuan
atau pemahaman untuk mengedit gambar
yang telah dibuat. Ada beberapa editing
yang biasa dilakukan pada saat meng-
gambar dengan CorelDraw. Kegiatan
editing yang dilakukan meliputi: (1) me-
milih, memindahkan, dan menggandakan
objek; (2) memperbesar gambar; (4) meng-
atur posisi objek; (5) membuat group atau
ungroup objek; (6) transform objek; dan
(7) menggunakan power clip.

Untuk memilih, memindahkan meng-
gunakan pick tool, dan untuk mengganda-
kan objek (copy tool). Memperbesar gam-
bar menggunakan zoom tool, dan untuk
menggeser gambar menggunakan hand
tool. Mengatur posisi objek (allign dan
order). Transform (mengubah) objek ter-
diri dari size (mengubah ukuran objek),
scale (skala objek), skew (memiringkan
objek), rotate (memutar objek), mirror
(pencerminan atau membalik objek). Pe-
rintah mengikat objek group atau mem-
buka ikatan objek (ungroup). Perintah
untuk meleburkan, memotong, dan meng-
hasilkan objek adalah combine, weld, trim,
intersect, simplify, front minus back, dan
back minus font. Menggunakan power
clip dengan mengambil dari menu bar »
effect » power clip » place inside con-
tainer.

DESAIN KAOS DISTRO DENGAN
CORELDRAW

Kaos atau t-shirt, berasal dari kata
shirt dan T karena bentuk awalnya me-
nyerupai huruf T (Assyaugi, 20080).
Desain kaos atau t-shirt pada saat ini
makin bervariasi, hal ini sesuai dengan
kreatifitas masing-masing penciptanya.
Seperti disebutkan Hariyadi (2007), bah-
wa desain kaos distro merupakan salah
satu trend desain yang marak akhir-khir
ini. Ciri khas dalam desain ini sangat
diminati masyarakat, terutama kalangan



anak muda. Selain berfungsi sebagai
fashion, kaos distro juga merupakan sim-
bol apresiasi seni bagi pemakainya.

Pada bagian ini akan diberikan be-
berapa contoh desain kaos distro dengan
menggunakan CorelDraw. Contoh desain
kaos distro yang ditampilkan dalam arti-
kel ini relatif sederhana. Desain kaos distro
tersebut, menggunakan objek garis (line),
kotak (rectangle), lingkaran (circle), dan
kata- kata (artistic text).

Desain Kaos Distro dari Objek Garis

Untuk membuat desain kaos distro
dari objek garis, langkah-langkahnya se-
bagai berikut: (1) menyiapkan lembar
kerja CorelDraw, buat ukuran drawing
page lebih besar dari ukuran kaos, mem-
buat kotak atau rectangle dengan lebar
dan panjang sesuai dengan ukuran kaos;
(2) membuat motif garis sesuai dengan
desain yang akan dibuat; (3) mengguna-
kan perintah width untuk mempertebal
garis; (4) menggunakan perintah order
(motif garis order to front); (5) mengatur
warna (fill); (6) membuat desain kaos,
dan; (7) memindahkan motif yang telah
dibuat ke desain kaos yang sudah disiap-
kan.

|

Gambar 2. Desain Kaos Distro dari Objek
Garis

(Sumber: Rohmawati ed., 2004)

Desain Kaos Distro dari Objek Kotak
(rectangle)

Untuk membuat desain kaos distro
dari objek kotak (rectangle), langkah-
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langkahnya sebagai berikut: (1) menyiap-
kan lembar kerja CorelDraw, buat ukuran
drawing page lebih besar dari ukuran
kaos, membuat kotak atau rectangle de-
ngan lebar dan panjang sesuai dengan
ukuran kaos; (2) membuat motif kotak
sesuai dengan desain yang akan dibuat;
(3) menggunakan perintah pick tool, dan
copy; (4) menggunakan perintah order
(motif kotak order to front); (5) mengatur
warna (fill), (6) membuat desain kaos,
dan; (7) memindahkan motif yang telah
dibuat ke desain kaos yang sudah disiap-
kan.
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Gambar 3. Desain Kaos Distro dari Objek
Kotak (rectangle)

(Sumber: Rohmawati ed., 2004)

Desain Kaos Distro dari Objek Ling-
karan (circle)

Untuk membuat desain kaos distro
dari objek lingkaran (circle), langkah-
langkahnya sebagai berikut: (1) menyiap-
kan lembar kerja CoralDraw, buat ukuran
drawing page lebih besar dari ukuran
kaos, membuat kotak atau rectangle de-
ngan lebar dan panjang sesuai dengan
ukuran kaos; (2) membuat motif lingkaran
sesuai dengan desain yang akan dibuat
dengan berbagai ukuran; (3) mengguna-
kan perintah order; (5) mengatur warna
(fill); (6) membuat desain kaos; dan
(7) memindahkan motif yang telah dibuat
ke desain kaos yang sudah disiapkan.
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Gambar 4. Desain Kaos Distro dari Objek
Lingkaran (circle)

(Sumber: Rohmawati ed., 2004)

Desain Kaos Distro dari Objek Kata-
kata (artistic text)

Untuk membuat desain kaos distro
dari kata-kata (artistic text), langkah-
langkahnya sebagai berikut: (1) menyiap-
kan lembar kerja CoralDraw, buat ukur-
an drawing page lebih besar dari ukuran
kaos, membuat kotak atau rectangle de-
ngan lebar dan panjang sesuai dengan
ukuran kaos; (2) membuat motif lingkaran
sesuai dengan desain yang akan dibuat,
membuat kata-kata di bawah lingkaran;
(3) menggunakan perintah order; (5) me-
ngatur warna (fill); (6) membuat desain
kaos, dan; (7) memindahkan motif yang
telah dibuat ke desain kaos yang sudah
disiapkan.
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Gambar 5. Desain Kaos Distro dari Objek
Kata-Kata (Artistic Text)

(Sumber: Rohmawati Ed., 2004)

PELUANG USAHA BISNIS DISTRO

Seperti telah disebutkan di awal, bah-
wa bisnis distro saat ini sangat menjanji-
kan. Bisnis distro sudah menyebar di
seluruh Indonesia, untuk itu diperlukan
kreatifitas dari masing-masing distro un-
tuk tetap sukses. Hal ini senada dengan
pendapat Dana (2008), terjun pada bisnis
distro tidak membutuhkan modal yang
banyak, hanya kemampuan untuk me-
masarkan dan mendesain suatu produk
fashion agar tidak monoton, mengingat
konsumen lebih menyukai produk yang
memiliki variasi motif warna maupun
desain. Menurut Zulkarnain dan Hengki
(2007), bahwa bisnis distro umumnya
mengutamakan harga yang murah namun
tetap memperhatikan kualitas. Barang-
barang yang dijual rerata berkisar antara
Rp 35 ribu hingga Rp 200 ribu, sehingga
distro banyak disukai kalangan pelajar
dan anak muda. Menurut Kusuma (2007),
bila tertarik dengan bidang grafis dan
senang akan seni desain kaos, maka dapat
dijadikan peluang usaha dengan membuat
label clothing sendiri, dapat dengan me-
nuangkan ide melalui gambar, kemudian
orderkan kepada pihak sablon atau kon-
veksi.

Untuk membuka bisnis distro ada be-
berapa hal yang perlu diperhatikan agar
berhasil, yaitu masalah modal, produksi,
promosi, distribusi, dan keuntungan (Teh-
tawar, 2007).

Modal

Seperti disebutkan di atas, bahwa mem-
buka bisnis distro tidak membutuhkan
modal yang banyak. Untuk mem-buka
bisnis distro diperlukan keinginan yang
kuat atau minat dan motivasi yang besar
untuk memulainya, dengan demi-kian
yang dibutuhkan hanya menyewa tempat.

Produksi

Produksi dapat dilakukan pada pabrik
konveksi, untuk desain dan pola dari



pemilik distro. Bila desain daos distro
telah dibuat, langkah selanjutnya mem-
buat logo dan label produk. Untuk label
biasanya biasanya berupa hangtag spe-
sifikasi produk dan harga produk. Untuk
logo produk dibuatkan label di kerah dan
dibuat dengan bordir komputer (Sukir-
man, 2009).

Promosi

Untuk promosi dapat dilakukan dari
mulut ke mulut atau melalui spanduk,
brosur, leaflet, dll. dengan tujuan agar
masyarakat atau calon konsumen tertarik
untuk mengunjungi disronya. Bila telah
berkembang dapat melalui media massa
(koran, majalah, radio, internet, dll.) dan
sponsor acara atau artis.

Distribusi

Distribusi dapat dilakukan melalui
konsinyasi atau bagi hasil dengan distro-
distro merk lain dimana barangnya di-
titipkan. Selain itu, distro dapat menya-
lurkan produknya ke kota-kota lain, bah-
kan mancanegara. Untuk penjualan ke
mancanegara biasanya dilakukan dengan
sistem bel putus, maka ongkos kirimnya
dibagi dua dengan pembeli.

Keuntungan

Untuk pendapatan kotor biasanya be-
ragam bergantung dari masing-masing
distro. Untuk keuntungan dari menitipkan
barang dengan sistem konsinyasi adalah
dibagi dua dengan distro yang menitip-
kan barang.

PENUTUP

CorelDraw merupakan program apli-
kasi yang banyak dimanfaatkan oleh ka-
langan profesional dalam pembuatan
desain grafis. CorelDraw dibuat dengan
alat-alat atau perintah-perintah yang mu-
dah untuk digunakan. Biasanya program
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ini digunakan untuk keperluan cetak,
web, maupun untuk keperluan lainnya.

Dengan demikian, bila terampil atau
dapat memanfaatkan CorelDraw dengan
baik, akan menjadi peluang usaha untuk
membuka bisnis distro, karena dalam
bisnis distro yang penting adalah terampil
mendesain kaos distro, untuk produksi-
nya dapat diserahkan kepada konveksi,
sehingga yang dibutuhkan hanya menyewa
tempat.

Saat ini bisnis telah banyak, sehingga
persaingan dalam merebut hati konsumen
cukup ketat. Untuk itu, dalam menghadapi
persaingan tersebut perlu kiat mem-
bangun brand image yang kuat, dengan
kata lain dapat melakukan hal yang ber-
beda dengan saingannya.
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